CECT LORSQUE TU commences 4 manipuler d’importantes quantités de données
que la programmation trouve tout son intérét. Ton programme devient alors une série
de régles qui déterminent la maniére dont ces données vont étre lues et traitées et la
forme qu'elles vont prendre. C'est & partir de 14 que les données vont commencer 4 jouer
un r6le important.

Dans ce chapitre, tu vas d’abord apprendre a créer des fichiers de texte qui vont te ser-
vir & concevoir des labyrinthes. Cela te permettra de construire automatiquement des
labyrinthes dans Minecraft pour que tes amis et toi puissiez vous y perdre. Tu verras
qu'avec un petit programme Python, il est possible de construire des structures aussi
grandes que des labyrinthes. Tu n'en croiras pas tes yeux !

Tu vas ensuite t'inspirer de ton programme de création de labyrinthe pour en dévelop-
per un autre beaucoup plus complet, qui te permettra de batir une gigantesque struc-
ture de scannage et d'impression en 3D, également appelée salle de reproduction. Tout
ce que tu confectionneras a l'intérieur pourra étre enregistré dans un fichier et réuti-
lisé plus tard. Tu pourras notamment téléporter tes objets & des endroits différents
dans Minecraft et méme les charger sur d’autres ordinateurs pour les faire apparaitre
chez tes amis | Tu te constitueras ton propre répertoire dobjets et pourras les repro-
duire si rapidement dans Minecraft que tous tes amis voudront eux aussi posséder une
machine 3 dupliquer !
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Lire une donnée dans un fichier

Un programme informatique n'est pas aussi intelligent qu'il en a l'air : il se contente
bétement de suivre les instructions quon lui donne. Si on ne change aucune donnée
du programme, il s'exécutera toujours de la méme maniére. Les programmes Minecraft
que tu as réalisés jusqua présent sont assez interactifs, car ils changent de comporte-
ment en fonction des événements qui surviennent dans le jeu. Ces événements consti-
tuent des données pour le programme.

1l existe une autre maniére de changer le comportement d'un programme informatique
chaque fois que tu I'exécutes : tu peux enregistrer des données dans un fichier texte et
demander 4 ton ordinateur de le lire au démarrage. Tu peux alors créer tout un dossier
de fichiers de texte et méme rédiger un menu pour choisir le fichier 4 ouvrir en fonction
de ce que tu souhaites réaliser avec le programme. On dit de ce type de programme qu’il
est « orienté donnée », car ce sont principalement les données stockées dans le fichier
de texte externe qui vont l'influencer.

En y réfléchissant, la plupart des programmes que tu utilises sur ton ordinateur font déja
appel 4 des fichiers de données. Le programme de traitement de texte que tu utilises pour
faire tes devoirs enregistre ton travail dans un fichier de données ; lorsque tu prends une
photo avec un appareil numérique, elle est stockée dans un fichier de données et ton pro-
gramme d'édition de photo accéde 4 ton image depuis ce fichier. Méme Minecraft utilise des
fichiers de données en coulisses, pour enregistrer ou charger ton monde par exemple, mais
aussi pour les kits de textures qui servent  personnaliser tes blocs. Utiliser des fichiers de
données dans un programme te permet de travailler en toute flexibilité, car tu peux ainsi
lui demander d’exécuter tout un tas de tAches différentes, sans pour autant avoir besoin
de le modifier A chaque fois pour y parvenir. Lavantage est que tu peux aussi partager ces
fichiers de données avec tes amis, si toutefois ils possédent le méme programme que toi.

Le programme que j'ai publié sur mon blog il y a quelque temps est un bel exemple
d'utilisation de fichiers de données dans Minecraft. Je Iai baptisé le « Constructeur
BMP de Minecraft » (http://blog.whaleygeek.co.uk/minecraft-pi-
with-python/), car il permet de lire une image depuis un fichier bitmap (BMP)
et de la reproduire bloc par bloc dans Minecraft. Grace a ce programme, j'ai pu
reproduire le logo de Raspberry Pi a I'identique dans le jeu. Il est tellement énorme
que lorsqu’on se trouve a la base et qu’on leve la téte pour le regarder, on a du mal a
croire qu'il s"agit du logo ! Ce programme est capable de lire n'importe quelle image
BMP et de la reproduire a I'identique dans le jeu, sans qu’on ait besoin d'intervenir.

Lorsquon écrit un programme orienté données, il faut tout d’abord savoir ouvrir et lire
des fichiers texte depuis son ordinateur 4 'aide de Python.
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Pour apprendre 4 ouvrir et lire des fichiers texte, tu vas devoir écrire un programme rela-
tivement simple de donneur d’indices. Ce programme va te permettre de lire un fichier
texte contenant des trucs et astuces sur le jeu Minecraft et d’afficher ces conseils un par
un sur le chat, de maniére aléatoire. Pour cela, tu dois d'abord créer un fichier et y rédiger
des indices. Tu peux le faire dans I'éditeur Python, comme pour les programmes.

Lance Minecraft, IDLE ainsi que le serveur si tu es sur un PC ou un Mac. Tu tles déja
certainement un peu familiarisé avec le processus, mais n’hésite pas a relire le cha-
pitre 1 si tu as besoin de te rafraichir la mémoire.

1. Dans IDLE, crée un nouveau fichier de texte en cliquant sur File>New File
dans le menu. Enregistre ton programme en le nommant astuces . txt.

2. Puis énumeére quatre ou cing astuces en plagant chacune sur une ligne de texte.
Ci-apres, j’ai rédigé quelques exemples d’astuces Minecraft pour t'aider, mais cela
sera beaucoup plus amusant si tu inventes tes propres astuces. N'oublie pas d’ap-
puyer sur Entrée ala fin de chaque ligne, pour créer une fin de ligne al'intérieur
du fichier lorsque tu changes d’astuce. Tu en sauras davantage sur les fins de ligne
un peu plus tard dans ce chapitre.

Construis-toi un abri avant que les monstres n'apparaissent <
et ne viennent te dévorer.

Utilise des blocs d'eau pour alimenter des canaux souterrains.
Construis une structure en sable et détruis la base.

Utilise les deux modes de vue a la premiére et a la ¢«
troisiéme personne.

Appuie deux fois sur la barre d'espace pour voler dans le ciel.

3. Enregistre ce fichier. Ne I'exécute pas puisqu’il ne s’agit pas d'un programme
Python mais d'un fichier de texte que tu vas demander 4 Python d'utiliser.

Une fin de ligne est un caractére spécial invisible que I'ordinateur utilise pour
marquer la fin d'une ligne de texte.

On I'appelle aussi parfois un « retour chariot », qui date de I'époque ou on utilisait
encore les machines a écrire. Lorsqu’on voulait aller a la ligne, on utilisait le retour
chariot, qui faisait revenir le chariot a gauche de la page, une ligne plus bas.

N'utilise pas de virgule dans ton fichier astuces . txt, ni dans aucun des messages
que tu veux faire apparaitre avec mc . postToChat (). LAPI de Minecraft comporte
un petit bug qui coupe les phrases a I'endroit ol on a placé une virgule.
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Maintenant que tu as créé ton fichier d’astuces, cest-a-dire de données, il est temps de
passer al'écriture du programme qui va les traiter. Ce programme choisira une astuce au
hasard dans le fichier et I'affichera au bout d'un certain temps dans le chat de Minecraft.
Ainsi, pendant que tu joueras, tu verras s’afficher des conseils utiles.

1. Ouvre un nouveau fichier en cliquant sur File>New File et enregistre-le enle
nommant astuceChat . py.
2. Importe les modules dont tu as besoin :
import mcpi.minecraft as minecraft
import time
import random
3. Puis connecte-toi au jeu Minecraft :
mc = minecraft.Minecraft.create()
4. Définis ensuite une constante avec le nom du fichier pour pouvoir I'échanger faci-
lement par la suite avec un autre fichier :
NOMDEFICHIER = "astuces.txt"
5. Ouvre le fichier en mode de lecture (référe-toi i I'encadré « Percer les secrets du
code » pour obtenir plus de précisions sur cette étape) :
f = open (NOMDEFICHIER, "r")
6. Et lis toutes les lignes du fichier dans une liste que tu nommeras astuces.

Souviens-toi que tu as déja utilisé des listes dans les chapitres 4 (constructeur de
pont magique) et 5 (électronique) :

astuces = f.readlines()
7. Puis ferme le fichier lorsque tu auras terminé de le lire. Dés lors que tu as fini
d'utiliser un fichier, il faut toujours penser a le refermer, car s'il reste ouvert il ne

pourra pas étre utilisé par d’autres applications, telles que I'éditeur dans lequel tu
as rédigé ton premier texte :

f.close()
8. Maintenant rédige une boucle de jeu avec des temps d’attente aléatoires, oscil-
lant entre trois et sept secondes :
while True:

time.sleep (random.randint (3,7))

9. Ensuite, dis au programme de choisir un message aléatoire dans la liste astuces et
delafficher sur le chat. Pour cela, tu dois utiliser la fonction strip () (qui veut dire
déshabiller ou dépouiller), pour te débarrasser de tous les caractéres de fin de ligne
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superflus. Tu en sauras plus sur les caractéres de fin de ligne un peu plus tard, donc
ne t'inquiéte pas si tu ne comprends pas bien de quoi il retourne pour l'instant.

msg = random.choice (astuces)
mc .postToChat (msg.strip())

Enregistre ton programme et exécute-le. Que se passe-t-il ? A mesure que tu avances
dans le monde de Minecraft et que tu joues, tu devrais voir une astuce s’afficher sur le
chat au petit bonheur, comme sur la figure 6-1. Observe la maniére dont les messages
apparaissent. Tu verras qu'ils disparaitront petit 4 petit.

FIGURE 6-1 Des astuces apparaissent de fagon aléatoire sur le chat au fil du jeu.

DEFI

Ajoute des astuces a ton fichier astuces. txt en t'aidant de ton expérience

du jeu Minecraft. Donne ton fichier astuces.txt et ton programme 4
astuceChat .py a un ami qui débute dans Minecraft afin qu’il puisse I'utiliser w E
et réaliser des choses extraordinaires dans le jeu. Tu peux méme écrire toute - .

une série de fichiers astuces.txt sur des themes différents et contenant v
plus ou moins de détails selon le niveau des joueurs. Publie-les ensuite sur un

petit site Internet et laisse-les en libre accés pour que d'autres joueurs puissent

les utiliser, sans oublier de partager aussi le programme astuceChat . py.
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PERCER LES SECRETS DU CODE

Dans le programme astuceChat.py, la ligne suivante renferme un petit
mystere :

f = open (NOMDEFICHIER, "r")

La fonction open() permet d”ouvrir le fichier affect¢é a la constante
NOMDEFICHIER. Mais que signifie le « r » a la fin ? Lorsque tu ouvres un fich-
ier, tu dois préciser a la fonction open () le niveau d'accés que tu souhaites lui
attribuer. Ici, le « r » (pour « read », qui signifie « lire » en anglais) te permet
d’ouvrir le fichier en mode lecture uniguement. Si jamais tu essayes de modi-
fier le texte du fichier, tu recevras un message d’erreur. Cette fonctionnalité te
permet de protéger tes fichiers contre tout dysfonctionnement. Si tu veux
ouvrir un fichier et le modifier, tu peux utiliser la lettre « w » (pour « write », qui
signifie « écrire » en anglais) ; et si tu veux faire les deux a la fois, utilise « rw »
(pour lire et écrire dans le fichier).

Enfin, que signifie le £ ? Le £ est en fait une autre variable, qui stocke ce qu‘on
appelle un descripteur de fichier. Un descripteur de fichier te permet de
« saisir » un fichier. C'est une sorte de référence virtuelle du fichier qui se
trouve dans le systéme de ton ordinateur. Si tu veux réaliser quelque chose sur
un fichier ouvert, utilise la lettre £ pour pouvoir t'y référer. Cette variable est
trés pratique, car comme toutes les autres variables que tu as utilisées aupara-
vant, tu peux ouvrir plusieurs fichiers a la fois avec plusieurs variables de fichier,
comme cela :

f1 = open("config.txt", "r")
f2 = open("niveaux.txt", "r")
f3 = open("score.txt", "rw")

Tu peux utiliser les variables £1, £2 et £3 dans la suite de ton script pour iden-
tifier correctement les fichiers que tu souhaites lire ou modifier.

Construire des labyrinthes
a l'aide d'un fichier de données

Maintenant que tu sais comment demander a tes programmes de lire des fichiers de
données, tu es prét pour l'aventure. Tu sais déja & quel point il est simple de placer des
blocs dans le monde de Minecraft, grice aux chapitres précédents. Mais que dirais-tu
si tu pouvais construire des blocs en utilisant des listes de blocs répertoriées dans un
fichier de données ? Cest exactement ce que tu vas faire ici : tu vas construire un grand
labyrinthe en 3D dans Minecraft, en enregistrant les données de ton labyrinthe dans
un fichier externe | Mais avant tout, tu dois définir la maniére dont tu vas organiser tes

données dans le fichier.
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Tu peux regarder une vidéo didactique sur la création d’un labyrinthe en te rendant
sur le site Internet du livre www . editions-eyrolles.com/d1l/14292. Choisis
la vidéo « Adventure 6 » (en anglais).

Les labyrinthes que tu vas concevoir ici sont en 3D, car tu vas les construire dans un monde
en 3D. Mais en réalité ce sont des labyrinthes en 2D construits 4 partir de blocs en 3D, car ils
ne comportent qu'une seule couche. En dair, tu ne devras enregistrer que les données x et z
de chaque bloc du labyrinthe dans ton fichier, pour que celui-ci soit rectangulaire.

Tu devras également décider de I'agencement de tes blocs dans le fichier de données.
Enfin, comme tu n’utiliseras que des murs et de Iair, le chiffre 1 représentera les murs et
le O représentera l'air. Tu pourras toujours modifier plus tard les types de blocs servant
ala construction d'un mur a l'intérieur de ton programme Python.

Pour ce programme, tu vas utiliser un fichier texte un peu spécial, qui sappelle CSV. 11
te permettra de définir tes labyrinthes sous la forme de fichiers au sein du systéme de
fichiers de ton ordinateur.

Un fichier CSV est un fichier qui contient des valeurs séparées par des virgules.
On vy écrit des valeurs sous forme de texte et on les sépare par des virgules.
Dans un fichier CSV, il est possible de créer un tableau ou une base de données
simple. Chaque ligne du fichier représente une rangée du tableau ou une donnée
de la base de données ; et le texte des lignes entre les virgules représente
une colonne du tableau ou un champ. Certains fichiers CSV utilisent la premiére
ligne du fichier pour enregistrer les titres des colonnes du tableau ou les noms
des champs. Toutes les applications de tableur et de base de données les plus
connues sont compatibles avec les fichiers CSV.

\)%’EF/,V,/>

Le format CSV est trés simple et son utilisation est trés répandue. Voici un exemple de texte
CSV issu d'un tableau de base de données rassemblant des informations sur des joueurs
de Minecraft. Dans ce fichier CSV, la premiére rangée (ou ligne) est réservée aux noms des
champs et toutes les autres lignes comportent des données séparées par des virgules :

Nom, Pseudo, Spécialité

David,w_geek,Le code en Python
Roma,physics_gurl,La conception de grands batiments
Ryan,mr_teck,Les robots Minecraft

Craig, rrrrrrrr, Expert TNT
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Ce fichier CSV contient donc une rangée avec les titres Nom, Pseudo et Spécialité.
Il contient également quatre rangées de données, comportant chacune trois champs.

Lorsgu’on congoit des structures complexes en informatique, il est parfois utile d'avoir
recours a d'autres outils. En tant qu‘ingénieur informatique, jutilise réguliérement les
tableurs pour concevoir et représenter des données. lls constituent un formidable
moyen de créer des tableaux de données, car on peut les exporter au format CSV et
les charger ensuite dans d'autres applications. Pour t'entrainer, essaye de concevoir
un labyrinthe dans ton application de tableur favorite. Crée des colonnes étroites et
utilise les formules pour remplir tes cellules en blanc lorsque tu saisis le chiffre 0
et en jaune lorsque tu saisis le chiffre 1. Une fois que tu as visualisé ton labyrinthe
de cette maniere, exporte-le au format CSV et nomme-e labyrinthe.csv, puis
exécute ton programme et amuse-toi a te perdre avec tes amis |

Dans le fichier de données de ton labyrinthe, tu n’as pas besoin d’une rangée de titres,
car chaque colonne du tableau comporte le méme type de données,  savoir le chiffre 0
pour représenter le vide et le chiffre 1 pour représenter un morceau de mur. Tu peux
télécharger le fichier du labyrinthe depuis le site Internet du livre, mais voici son
contenu si tu préféres le créer toi-méme.

1. Créeunnouveau fichier en cliquant sur File>New File.Clique sur File>Save
As et nomme ton fichier 1abyrinthel.csv.

2. Saisis les lignes suivantes en les recopiant méticuleusement et fais attention a
conserver le méme nombre de colonnes sur chaque ligne. Si tu observes ces don-
nées de prés, tu devrais déja pouvoir te faire une idée de la structure du labyrinthe !
Au total, il contient 16 lignes, avec 16 chiffres par ligne, alors tu peux t'aider d'un
crayon pour vérifier que tu prends bien toutes les données en compte :
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3. Enregistre ce fichier. Tul'utiliseras lorsque tu auras écrit le programme Python te
permettant de lire et de traiter ces données.

Maintenant que tu disposes d’'un fichier de données détaillant la structure de ton laby-
rinthe, il ne te reste plus qu'a rédiger le programme Python qui va lire ces données et
construire ton labyrinthe dans Minecraft avec des blocs.

1. Ouvre un nouveau fichier en cliquant sur File>New File, puis enregistre-le en
cliquant sur File>Save As et nomme-le constructionCSV.py.

2. Importe les modules dont tu as besoin :

import mcpi.minecraft as minecraft
import mcpi.block as block

3. Et connecte-toi au jeu Minecraft :

mc = minecraft.Minecraft.create()

4. Définis quelques constantes. La constante ESPACE est le type de bloc que tu vas
utiliser entre les murs. Normalement, tu y mettras de l'air, mais tu peux aussi
essayer d’y inclure d’autres types de blocs pour rendre ton labyrinthe encore plus
intéressant. La constante MUR est le type de blocs que tu vas utiliser pour créer les
murs de ton labyrinthe. Tu dois donc faire attention a ce que tu choisis, car cer-
tains blocs ne permettent pas de batir des murs solides. Quant 4 la constante
SOL, elle sert de base a ton labyrinthe :

ESPACE = block.AIR.id
MUR block.GOLD_ BLOCK.id
SOL block.GRASS.id

N’utilise pas le SABLE pour le sol de ton labyrinthe. Si jamais tu poses du sable
comme fondation, il se peut que le sol se dérobe sous les pieds de ton joueur en
fonction du terrain sur lequel il se trouve !

5. Ouvre le fichier contenant les données de ton labyrinthe. Ici, tu vas utiliser la
constante NOMDEFICHIER, pour te faciliter la tiche lorsque tu modifieras plus
tard le nom du fichier afin de lire des données de labyrinthe différentes :

NOMDEFICHIER = "labyrinthel.csv"
f = open (NOMDEFICHIER, "r")

6. Localise ton joueur et calcule les coordonnées de I'angle inférieur de ton laby-
rinthe. Ajoute 1 aux coordonnées x et z de ton joueur afin d’éviter de construire le

CHAPITRE 6 UTILISER DES FICHIERS DE DONNEES

173



174

7

8

9

10.

11.

labyrinthe sur sa téte. Tu peux également t'amuser a construire le labyrinthe
dans le ciel en modifiant la coordonnée y :

pos = mc.player.getTilePos ()

ORIGINE X = pos.x+1

ORIGINE Y = pos.y
ORIGINE Z = pos.z+l
. Comme la coordonnée z variera a la fin de chaque ligne de données, commence

par celle du point de départ de ton labyrinthe. Elle changera légérement plus tard
dans le programme.

z = ORIGINE_Z

. Tuvas maintenant faire tourner une boucle sur toutes les lignes du fichier. Pour
cela, lis attentivement I'encadré « Percer les secrets du code », qui t'explique
toutes les étapes de la fonction readlines (). La boude for te permet de lire
chaque ligne du fichier une 4 une. A chaque tour de boudle, la variable 1ine
contient la donnée de la ligne qui vient d’étre lue :

for line in f.readlines():

. Tu vas maintenant diviser la ligne en plusieurs parties, 1 ot sont placées les vir-
gules. Pour en savoir plus sur la fonction split (), consulte I'encadré intitulé
« Percer les secrets du code ». Souviens-toi que les lignes qui font partie du corps
de la boudle for doivent étre indentées d’'un cadratin :

data = line.split(",")

Fais bien attention a cette étape, car tu vas introduire une autre boucle for. Cest
ce qu'on appelle une boucle imbriquée, car une boucle for est imbriquée dans
une autre for. Dans ton programme, tu vas devoir réinitialiser la coordonnée x
au début de chaque nouvelle rangée du labyrinthe. C'est pourquoi, tu dois le faire
en dehors de la boucle for qui dessine une rangée entiére :

X = ORIGINE X
for cell in data:

Tous les chiffres que le programme va lire dans la ligne seront considérés comme
du texte (une chaine de caractéres), donc tu devras placer des guillemets droits "
autour de chacun pour que ton programme puisse fonctionner. L'instruction i £/
else te permet de construire soit un espace soit un mur en fonction du chiffre
que le programme aura lu dans le fichier CSV. Pour rappel, le O correspond 4 un
espace et toute autre donnée conduit 4 la construction d'un mur. Fais bien atten-
tion 4 l'indentation dans ce passage : I'instruction if est indentée deux fois, car
elle fait partie de la boucle for cell in data, qui fait elle-méme partie de la
boucle for line in f.readlines ().Lavariable b est quant i elle trés utile,
car elle permet de raccourcir et de simplifier le programme. (Essaye de réécrire ce
passage en omettant volontairement la variable b et tu verras ce qu’il se passe !)
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if cell == "O":

b ESPACE
else:

b = MUR
mc.setBlock (x, ORIGINE_ Y, z, b)
mc.setBlock (x,ORIGINE_Y+1, z, b)
mc.setBlock (x, ORIGINE_Y-1, z, SOL)

12. Mets la coordonnée x  jour 4 la fin de la boucle for cell. Cette ligne doit étre
indentée, car elle saligne sur l'instruction précédente mc.setBlock () et elle
fait partie du corps de laboucle for cell in data.

Xx=x+1

13. Mets la coordonnée z 4 jour 4 la fin de la boucle qui traite chaque rangée de don-
nées. Ne I'indente que d’'un niveau, car elle fait partie de laboucle for line in
f.readlines().

z =2z + 1

Enregistre ton programme et vérifie bien tous tes niveaux d’indentation. Si jamais tu
te trompes, le programme ne fonctionnera pas comme prévu et tu obtiendras un laby-
rinthe vraiment trés étrange !

Exécute ton programme et tiens-toi prét A voir apparaitre un superbe labyrinthe sous
tes yeux. Parcoure ses allées et essaye d’en trouver la sortie sans briser les murs et sans
tenvoler dans les airs. Sur la figure 6-2, tu peux voir 4 quoi il ressemble de I'intérieur.

FIGURE 6-2 Vue de I'intérieur du labyrinthe dans Minecraft
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Si tu es égaré et que tu ne trouves pas la solution, tu auras toujours la possibilité de tri-
cher un peu et de tenvoler pour voir ton labyrinthe d’en haut, comme sur la figure 6-3.

FIGURE 6-3 Vue aérienne du labyrinthe dans Minecraft

DEFIy,,
6Z Une boucle imbriquée est une boucle a l'intérieur d'une autre boucle. On
appellera la premiére une « boucle externe », et la deuxieme une « boucle
interne ». En Python, on imbrique une boucle dans une autre en I'indentant d'un
niveau supplémentaire. On peut imbriquer plusieurs boucles les unes dans les
autres autant de fois qu‘on le souhaite.
- J

Si tu laisses des lignes vides a la fin de ton fichier de données, elle seront lues
et interprétées par ton programme Python. Heureusement, cela n'aura aucune
incidence sur ton programme, mais il se peut que cela provoque la création de
blocs en trop a la fin de ton labyrinthe.

PERCER LES SECRETS DU CODE

Dans les chapitres précédents, tu as appris a utiliser les listes Python et tu sais
désormais qu'elles peuvent regrouper une série d'objets a des emplacements
numérotés. Plusieurs fonctions inhérentes au langage Python fournissent
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des données sous forme de liste, comme tu viens de le voir dans le constructeur
de labyrinthe.

Cette ligne de code en est I'exemple :
for line in f.readlines():

Souviens-toi que fest un descripteur de fichier, ¢c’est-a-dire quelque chose dont
tu peux t'emparer pour accéder a un fichier ouvert. Le type file dans Python
posséde une fonction intégrée qui s'appelle readlines (). Elle permet sim-
plement de lire chaque ligne du fichier et de les accoler une a une a la fin de la
liste. Tu dois également te souvenir, grace aux chapitres précédents, que lors-
qu’on inclut une liste dans une boucle for, celleci passe en revue tous ses
objets.

Tout ce que la boucle for fait, c'est qu’elle lit toutes les lignes d’un fichier qui
se trouvent au sein d'une liste et qu’elle les passe en revue I'une apres |'autre.
A chaque tour de boucle, la variable 1ine (c’est-a-dire la variable de contréle de
boucle) s'empare de la ligne de données suivante.

Par exemple, si ton fichier contient trois lignes, comme ceci :

ligne un
ligne deux
ligne trois

la fonction £ .readlines () renverra une liste ressemblant a ceci :
[‘1ligne un', ‘ligne deux', ‘ligne trois']

Par ailleurs, tu as déja utilisé une liste dans une autre partie de ton script, mais
peut-étre que tu ne t'en es pas apercgu. C'était ici :

data = line.split(",")

La variable 1ine contient une chaine de caractéres qui correspond au texte
d’une ligne compléte du fichier CSV. Toutes les variables contenant une chaine
de caracteres comportent une fonction intégrée qui s'appelle split (). Cette
fonction divise la chaine de caractéres pour en faire une liste. Les caractéres
n v entre parenthéses indiquent a la fonction split I'endroit ol la séparation
doit s'opérer.

Imagine que tu disposes d'une variable 1ine comportant trois mots séparés
par une virgule, comme ceci :

line = "un,deux,trois"

data line.split (", ")

Ta variable data comportera alors une liste de trois objets, ce qui donnera le
résultat suivant :

[‘un', 'deux', 'trois']
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Congois ton propre labyrinthe dans un autre fichier CSV en dessinant beaucoup
d'allées sinueuses, d'impasses et de spirales pour rendre la tache encore plus
ardue. Mets tes amis au défi de retrouver la sortie. Tu peux t'amuser a cacher
des trésors ¢a et la (en utilisant par exemple un DIAMOND BLOCK, c’est-a-dire
un bloc de diamant) ainsi qu‘a la sortie du labyrinthe pour que tes amis puissent
prouver qu'ils en ont exploré toutes les allées. Tu peux méme t'amuser a
construire un labyrinthe gigantesque qui recouvre tout le monde de Minecraft !
Trouveras-tu le moyen d’enregistrer la position des trésors dans le fichier du
labyrinthe ?

Lorsque j'ai congu les programmes de ce chapitre, j'ai dG apporter de légeres
modifications au programme du labyrinthe, car il était parfois trop difficile a
résoudre. Par exemple, que se passe-t-il si tu retires la ligne de code qui pose
les fondations du labyrinthe ? Essaye de construire les murs en utilisant d'autres
types de blocs, tels que le CACTUS ou I'EAU (WATER) et observe ce qu'il se
passe. J'ai d( tester le programme a plusieurs reprises avant de trouver les types
de blocs qui me convenaient pour la construction des murs et du sol !

Une erreur s’est glissée dans le programme et ¢’est a toi de la retrouver. Méme
si une ligne se termine par un 0 dans le programme du labyrinthe, il construira
un mur en or a la place. D'apres toi, quelle en est la raison ? Essaye de corriger
ce défaut par toi-méme. Indice : tu as déja résolu un probléme similaire dans le
programme astuceChat.py.

Dans ce chapitre, tu as utilisé les fonctions readlines () et split () pour
traiter des fichiers CSV. Python est un langage de programmation treés vaste et
déja tres reconnu, qui posséde de nombreuses fonctions intégrées. Tu peux
t'intéresser a son module intégré d'importation de CSV en cliquant sur import
csv, car ¢'est une méthode encore plus puissante que celle que nous avons
utilisée ici. En ce qui me concerne, je préfére développer mes programmes pas
a pas, parce que cela m‘aide a comprendre comment ils fonctionnent. C'est
pourquoi j'ai utilisé les fonctions readlines () et split () dans ce livre.
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Construire une imprimante
de blocs en 3D

On sest bien amusé A créer des labyrinthes, mais maintenant que tu sais utiliser des fichiers
de données, bien d’autres possibilités vont s'ouvrir A toi ! Nous avons construit une structure
avec deux types de blocs sur une seule couche, mais il serait dommage de se limiter a cela !
Pour créer ton imprimante et scanneur 3D, tu vas tappuyer sur ton programme de construc-
tion de labyrinthe, le but étant de pouvoir créer des répliques d’arbres, de maisons et de bien
dautres objets encore, en seulement quelques dics ! En réalité, il s'agit d'un constructeur de
blocs, mais j'aime bien I'idée de I'imprimante 3D. Car lorsque le programme se met en route,
tu peux voir les structures se construire rangée par rangée, comme le papier qui sort d'une
imprimante ou les objets qu'une imprimante 3D construit couche aprés couche.

Tu commences 4 te débrouiller plutét bien en programmation et chaque nouveau script
que tu écris est toujours plus compliqué que les précédents. Comme dans le chapitre
précédent, ou tu as rédigé ton programme a partir de fonctions, tu vas développer ce
programme pas a pas.

La technique qui consiste a transformer les différentes fonctionnalités d’un
programme en fonctions et a les rassembler ensuite dans un script plus grand est
trés courante chez les développeurs professionnels. Elle part du principe qu‘un
grand programme n’est qu‘une suite de petits programmes. Si la structure de ton
grand programme est correcte dés le départ, tu pourras approfondir tes fonctions
pas a pas tout en développant et testant ton programme. En général, j'aime bien
me créer des petites démos simples et rapides pour pouvoir montrer aux curieux
ce que mon programme est capable de réaliser.

Dans ton programme de labyrinthe, tu as enregistré des données dans un fichier CSV dans
lequel chaque ligne, ou rangée, correspond a une ligne de blocs dans Minecraft. Chaque
rangée comporte elle-méme des colonnes (séparées par des virgules) qui correspondent a
un bloc de 1a ligne. 1l s'agit 14 d'une structure en 2D, car elle pose un bloc uniquement sur
les coordonnées x et z du rectangle o tu as choisi de construire ton labyrinthe. Méme s'il
apparait dans le monde de Minecraft et qu'il est fait de cubes, le labyrinthe que tu as créé
est en réalité en 2D, car il ne comporte qu'une seule couche de blocs.

Pour construire des formes en 3D, tu vas devoir ajouter la dimension y a ton pro-
gramme. Si tu congois qu’'un objet en 3D est une succession de couches, le programme
que tu vas développer n'est pas tellement plus compliqué que celui que tu as écrit pour
batir ton labyrinthe. Pour créer un cube dont les faces mesurent cinq blocs de longueur
et cinq de largeur, il te suffit d'enregistrer cinq couches d’'informations.
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Seulement voil3, ce n'est pas aussi simple que cela. Ton programme Python ne connait pas
al'avance le nombre de lignes que le fichier contient. Il pourrait éventuellement en faire une
estimation approximative, mais il serait préférable de concevoir un format de fichier CSV
assez flexible pour que le programme puisse appréhender des objets de tailles différentes.

Pour résoudre ce probléme, tu vas ajouter ce que I'on appelle des métadonnées a la
premiére ligne du fichier, qui détaillent les dimensions de I'objet que tu vas construire.

vEF/A,,»
S Les métadonnées sont des données sur des données. Si ton fichier de données
contient des types de blocs servant a construire des objets, tu peux par exemple
apporter des précisions sur les dimensions des objets, leur nom ou le nom de leur
créateur en guise de métadonnées, c'est-a-dire les informations qui concernent
ces données. De méme que les métadonnées d'une photo enregistrée sur ton
ordinateur définissent la date et I'heure a laquelle elle a été prise ou méme le
nom de I'appareil photo, les métadonnées de ton imprimante 3D te permettront
d’obtenir tout un tas d'informations utiles sur tes objets en 3D.

N\ J

Tu vas maintenant batir une petite grotte en 3D, que tu peux voir 4 la figure 6-4, pour texer-
cer A tester les capacités d'impression en 3D de ton programme. Tu peux télécharger ce
petit objet depuis le site Internet des éditions Eyrolles (www.editions-eyrolles.com/
d1/14292) ou saisir les instructions qui vont suivre, comme tu l'as fait plus tot avec le
labyrinthe.

A Minecraft 1.6.4 [SE)Es

FIGURE 6-4& Tu as bati une petite grotte a |'aide d'un fichier CSV.
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Fais bien attention a laisser des lignes vides entre les différentes couches de
ton objet. Elles te permettent de voir ou commence chacune d’elles. De plus, le
programme Python que tu écris s'attend a tomber sur des lignes vides, alors si tu
les omets il ne fonctionnera pas correctement.

N’hésite pas a utiliser les fonctions copiercoller dans les étapes suivantes pour
éviter de saisir trop de code a la main et ainsi limiter les risques d’erreur.

1. Ouvre un nouveau fichier en cliquant sur File>New File et enregistre-le enle
nommant objetl.csv.

2. Saisis la premiére ligne de métadonnées relative aux dimensions de I'objet. Ton
objet de test aura les dimensions d’'un cube de 5 x 5 blocs, le x correspondant 4 1a
largeur, le y 4 1a hauteur et le z 4 la profondeur :

5,5,5

3. Saisis ensuite la premiére couche d’épaisseur de ton objet test, en t'assurant de
laisser une ligne vide avant la premiére ligne de données. Ta premiére couche de
blocs correspond aux fondations de 'objet ; tu dois donc remplir toute la surface
en saisissant a chaque fois le chiffre 1 qui correspond a I'emplacement de chacun

des blocs :

4. Le cube que tu construis est vide A l'intérieur et dispose d’'une ouverture, tu dois
donc dessiner trois couches avec ce format-1a. N'oublie pas de laisser une ligne
vide avant chacune des trois séries de chiffres :
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5. Copie cette série de chiffres et colle-la deux fois a la suite en t'assurant de laisser
une ligne vide avant chacune.

6. Puis termine en recouvrant ton objet d'une couche solide. Pour cela, copie les
rangées de données de l'étape 3, en laissant une ligne vide devant sa premiére
rangée de chiffres.

Enregistre ton fichier sans l'exécuter. De toute fagon, comme il ne s’agit pas d’'un fichier
Python, tu ne peux pas lexécuter. En revanche, pour I'utiliser tu devras créer un pro-
gramme Python et clest ce que nous allons faire dans la prochaine étape de ce chapitre.

Maintenant que tu as fini d'écrire tes données de test, il est temps que tu te mettes &
Técriture du programme de l'imprimante 3D qui te permettra de construire la grotte
dans le monde de Minecraft. Ce script ressemble beaucoup au programme du laby-
rinthe, A cela prés quil contient trois boucles imbriquées, c'est-a-dire une boucle pour
chacune des coordonnées x, y et z.

Ce programme est sans doute le plus élaboré que tu as écrit depuis le début de
ce livre. Prends le temps de I'écrire étape par étape pour le réussir du premier
coup et tu seras d'autant plus satisfait du résultat ! Si tu sens que tu bloques a
un certain point, commence par Vvérifier avec attention toutes tes indentations.
Et si tu es toujours bloqué aprés cela, n'oublie pas que tu as la possibilité de
télécharger tous les programmes de ce livre sur le site du livre a I'adresse
suivante : www.editions-eyrolles.com/dl/14292.

1. Ouvre un nouveau fichier en cliquant sur File>New File, puis enregistre-le en
cliquant sur File>Save As dansle menu et nomme-le impression3D.py.

2. Importe les modules dont tu as besoin :
import mcpi.minecraft as minecraft
import mcpi.block as block
3. Connecte-toi au jeu Minecraft :
mc = minecraft.Minecraft.create()
4. Crée une constante en lui attribuant le nom de ton fichier de données. Cela te

facilitera la tAche pour plus tard lorsque tu liras plusieurs fichiers contenant plu-
sieurs objets :

NOMDEFICHIER = "objetl.csv"
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5.

Définis une fonction impression3D (). Cette fonction te servira plus tard pour
la réalisation de ton projet final, donc veille & la nommer correctement :

def impression3D(nomdefichier, originex, originey, originez):

6.

10.

11.

Comme tu I'as fait pour ton programme de construction de labyrinthe, ouvre le
fichier de données en mode lecture et lis toutes les lignes dans une liste Python :

f = open(nomdefichier, "r")
lignes = f.readlines()

Le premier élément de ta liste se trouve 4 1'index 0. Il s’agit de la premiére ligne de
ton fichier, celle qui regroupe les métadonnées. Divise cette ligne en plusieurs
parties en utilisant la fonction split (). Enregistre ensuite ces trois nombres
dans les variables dimensionsx, dimensionsy et dimensionsz. Dans cette
étape, tu dois utiliser la fonction int (), car lorsque tu lis des lignes dans un
fichier, elles sont interprétées comme des chaines de caractéres. Or, tu as besoin
de les lire comme des nombres, car, plus tard, tu les utiliseras pour effectuer des

calculs.

coords = lignes[0] .split(",")
dimensionsx = int (coords[0])
dimensionsy int (coords[1])
dimensionsz int (coords[2])

Définis une variable idx1igne pour enregistrer I'index de la ligne dans la liste
lignes[] que tu utilises. Comme ton programme va parcourir la liste 1ignes
en lisant les données correspondant aux différentes couches de ton objet 3D, tu
ne peux pas utiliser cette variable comme variable de contréle de boucle :

idxligne = 1

La premiére boucle for parcourt chacune des couches verticales des données
lues dans le fichier. Les premiéres lignes du fichier correspondent 4 la couche qui
recouvre la base de I'objet, c’est-a-dire au niveau le plus bas des coordonnées y.
Pour que les étapes du processus d'impression soient visibles dans Minecraft, tu
peux ajouter une fonction postToChat () A cet endroit :

for y in range (dimensionsy)

mc .postToChat (str (y))

Ignore les lignes vides entre chaque couche dans ton fichier en ajoutant le chiffre 1
ala variable idx1igne. Comme tu le sais, ces lignes vides servent uniquement &
rendre la lecture du fichier plus agréable, ton programme doit les ignorer.

idxligne = idxligne + 1

Commence une boucle imbriquée for qui lira la prochaine ligne et la divisera en
plusieurs parties aprés chaque virgule. Fais bien attention a I'indentation ici ; la
boucle for doit étre indentée de deux cadratins (un pour la fonction et un pour
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la boucle for v) et le code a l'intérieur de la boucle for x doit étre indenté de
trois cadratins.

for in range (dimensionsx) :
ligne = lignes[idxligne]
idxligne = idxligne + 1
donnee = ligne.split(",")

12. Maintenant, commence la rédaction de ta troisiéme boucle for qui va parcourir
chacun des blocs de la ligne qui vient d’étre traitée et les construira dans
Minecraft. Laboucle for z estindentée de trois cadratins et le corps de la boucle
doit étre indenté quatre fois, donc sois bien vigilant en rédigeant ces lignes, sinon
tes objets auront une forme bien étrange !

for z in range (dimensionsz) :
blockid = int (donnee[z])
mc.setBlock (originex+x, originey+y, originez+z, <
blockid)

13. Enfin, saisis les lignes du programme principal, qui ne doivent comporter aucune
indentation. Elles vont lire la position de ton joueur et vont ensuite commander
ala fonction impression3D () d'imprimer ton objet en 3D juste & c6té de lui :

pos = mc.player.getTilePos ()
impression3D (NOMDEFICHIER, pos.x+l, pos.y, pos.z+l)

Sauvegarde ton programme et exécute-le. Que vois-tu ? Proméne-toi un peu dans le
monde de Minecraft et exécute le programme. A chaque fois, tu devrais voir apparaitre
une grotte en pierre juste a coté de ton joueur. Sur la figure 6-5, tu peux voir comme il
est simple de construire plusieurs grottes en pierre en un claquement de doigts.

A Crée d'autres fichiers CSV contenant des objets 3D, modifie la constante
¢ NOMDEFICHIER dans le script impression3D.py et exécute-le pour dissémi-
w , ner des objets un peu partout dans le monde de Minecraft. Comme tes objets
sont de plus en plus sophistiqués, tu peux t'amuser a imaginer plusieurs tech-
v niques de conception avant d’enregistrer les chiffres dans le fichier. Tu peux
par exemple les dessiner dans un tableur ou encore te procurer une grande
boite de cubes en plastique pour les construire en dur puis les reprendre couche
apres couche pour indiquer les numéros de bloc dans un fichier CSV.
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FIGURE 6-5 Impression 3D de plusieurs grottes en pierre dans Minecraft

Ton imprimante 3D est déja trés puissante. Tu peux créer une grande bibliothéque de
fichiers CSV pour construire tout un tas d'objets différents. Et dés que tu as besoin d'un
objet en particulier, il te suffit d'exécuter ton programme impression3D.py avec la
constante NOMDEFICHIER qui correspond a 'objet de ton choix pour le faire apparaitre
dans le monde de Minecraft.

En revanche, si tu souhaitais construire des objets plus complexes et plus grands, il te
faudrait saisir tous les chiffres dans le fichier CSV 4 la main et cette tiche s’avérerait
bien fastidieuse. Heureusement, le jeu Minecraft est idéal pour construire des objets
complexes. Alors, pourquoi ne pas lui demander de créer lui-méme ces fichiers CSV
pour toi ? Dans ce chapitre, tu vas apprendre A créer une copie identique d’'un arbre de
ton choix pour la reproduire un peu partout dans le monde de Minecraft. Présentée
ainsi, lopération semble difficile A réaliser, mais il n'en est rien ! Car scanner en 3D, clest
un peu comme imprimer en 3D 4 l'envers.

1. Ouvre un nouveau fichier en cliquant sur File>New File, puis enregistre-le en
cliquant sur File>Save As etnomme-le scannage3D.py.

2. Importe les modules dont tu as besoin :

import mcpi.minecraft as minecraft
import mcpi.block as block
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3. Connecte-toi au jeu Minecraft :

mc = minecraft.Minecraft.create()

4. Crée des constantes avec les noms des fichiers CSV et la taille de la zone que tu
souhaites scanner :

NOMDEFICHIER = "arbre.csv"
DIMENSIONSX 5
DIMENSIONSY 5
DIMENSIONSZ = 5

5. Définis une fonction scannage3D (). Tu l'utiliseras plus tard dans un pro-
gramme, donc assure-toi de la nommer correctement :

def scannage3D (nomdefichier, originex, originey, originez)

6. Dans cette fonction, ouvre le fichier de données que tu vas créer, mais cette
fois-ci en activant le mode de modification, c'est-a-dire en ajoutant "w" 4 l'inté-
rieur de la fonction open () :

f = open(nomdefichier, "w")

7. La premiére ligne du fichier doit contenir les métadonnées, tu dois donc y indi-
quer les valeurs des coordonnées x, y et z. Si tu veux connaitre la signification et
l'utilité du suffixe \n 4 la fin de la ligne de code, rends-toi dans I'encadré « Percer
les secrets du code ».

f.write(str (DIMENSIONSX) + "," + str (DIMENSIONSY) + "," <
+ str (DIMENSIONSZ) + "\n")

8. Leprogramme est'exact opposé du programme d'impression et posséde lui aussi
trois boucles imbriquées. Je I'ai affiché dans son ensemble afin que 'indentation
ressorte mieux et que tu puisses la retranscrire correctement. Pour en savoir plus
sur la maniére dont les lignes séparées par des virgules sont créées, lis I'encadré
« Percer les secrets du code » :

for y in range (DIMENSIONSY) :
f.write("\n")
for x in range (DIMENSIONSX) :
line = ""
for z in range (DIMENSIONSZ) :
blockid = mc.getBlock (originex+x, <
originey+y, originez+z)
if line != "":
line = line + ","
line = line + str(blockid)
f.write(line + "\n")
f.close()
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9. Pour finir, le programme principal ne contient aucune indentation. Ces derniéres
lignes détectent ta position, calculent un espace cubique autour de ton joueur et
demandent ensuite 4 la fonction scannage3D () de scanner tout cet espace
pour l'inclure dans ton fichier CSV.

pos = mc.player.getTilePos ()
scannage3D (NOMDEFICHIER, pos.x- (DIMENSIONSX/2), pos.y, ¢
pos.z- (DIMENSIONSZ/2))

Enregistre ton programme. Vérifie 3 nouveau que tes lignes de code sont bien indentées
avant de I'exécuter.

Maintenant, cours vers un arbre et appuie-toi contre son tronc, puis lance ton pro-
gramme scannage3D. py. Que se passe-t-il ?

Ne vois-tu rien se produire ? Cest tout 4 fait normal, souviens-toi que ce programme
scanne un objet a l'intérieur d’'un fichier CSV, donc tu dois regarder dans ton fichier
arbre.csv pour voir quels chiffres il contient désormais. Ouvre le fichier arbre.
csv en diquant sur File>Open dans éditeur. La figure 6-6 montre une section du
fichier arbre.csv que j'ai capturée aprés avoir embrassé un arbre | Comme l'espace
de scannage que jai défini est assez petit, il se peut que tu ne scannes qu’une petite
partie de l'arbre que tu as choisi. Tu peux remédier A cela en modifiant les constantes
DIMENSIONS de ton script pour scanner une zone plus grande.

B et Destop WineqaitAdverrsaMinecst O Adverrssarbrs L - Notepad=< LN == = M

Fichier Edition Recherche Affichage Encodage Langage Paramétrage Macro Exécution Compléments Documents ? X
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0,0,0,31,0
0,0,0,17,0
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2,2,31,0,31
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0,0,0,0,0
0,0,0,0,0
0,0,0,17,0
0,0,0,0,0 i
0,0,0,0,0
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0,0,0,0,0
0,0,0,0,0
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0,0,0,0,0
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Normal text file length:342 lines: 32 Ln:1 Col:1 Sel:0 Dos\Windows ANSI INS
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FIGURE 6-6 Contenu d'un fichier CSV apres scannage d'un arbre
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N’oublie pas que la direction dans laquelle ton joueur se tourne ne correspond
pas forcément a la position qui a été scannée, donc regarde bien tout autour de
toi. Le scanneur 3D numérise une zone comprise entre la position de ton joueur
et des valeurs de coordonnées plus élevées. Donc, si ton joueur se trouve a
I'emplacement 0,0,0, le scanneur 3D numérisera une zone comprise entre ces
coordonnées et des coordonnées plus élevées, par exemple 4,4,4. Réfere-toi au
schéma du chapitre 2, qui explique le principe des coordonnées et la direction
que chacune d’entre elles représente.

Normalement, IDLE n'ouvre que les fichiers dotés de I'extension .py dans
ses fenétres Open et Save, mais tu peux aussi visualiser tes fichiers .csv en
cliquant sur Files of Type>All Files

Maintenant que tu disposes d'un scanneur et d'une imprimante 3D, modifie ton
programme d‘impression 3D pour utiliser une constante NOMDEFICHIER du
fichier arbre.csv, puis proméne-toi un peu partout dans Minecraft tout en
exécutant le script impression3D.py. En faisant cela, tu devrais pouvoir par-
semer des arbres sur ton chemin. Essaye d'imprimer des arbres dans le ciel et
sous |'eau pour voir ce qui se passe. En combien de temps vas-tu parvenir a
faire pousser toute une forét ?

PERCER LES SECRETS DU CODE

Dans le programme scannage3D.py, tu as utilisé un caractére spécial au sein
de la fonction write (). Cela mérite une petite explication :

f.write("\n")

Le caractere \n (appelé « backslash n ») est un caractére spécial non imprimable
que Python te permet d'utiliser entre guillemets. Il signifie « passe a la pro-
chaine ligne ». La lettre n est l'initiale de « newline » (en frangais, « nouvelle
ligne »). Quant au backslash, la barre oblique inversée, il permet de distinguer
cette lettre n d'une lettre n normale.
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Dans le script scannage3D. py, tu as congu ton f chier de sorte a laisser une
ligne vide entre chacune des couches de données de ton objet pour faciliter la
lecture et la modif cation du f chier CSV par d'autres personnes. L'instruction
f.wite("\n") réalise exactement la méme chose : elle insere une ligne
vide dans ton f chier.

Plus loin dans le programme scannage3D. py, tu peux t'amuser a rédiger du
code autour de la variable | i gne. En voici les instructions les plus importantes :

for x in range(Dl MENSI ONSX) :
ligne =""
for z in range(Dl MENSI ONSZ) :
bl ocki d = nt. get Bl ock(ori gi nex+x, ori gi ney+y, ¢
ori gi nez+z)
if ligne !="": #la ligne n'est pas vide
ligne =ligne +","
ligne =1ligne + str(bl ockid)

Le code souligné correspond a un modele de codage tres répandu, générale-
ment utilisé pour créer des valeurs séparées par des virgules. Au début de la
boucle x, on affecte une chalne de caracteres vide a la variable. Chaque fois
que la boucle z produit une autre valeur, elle vérif e d'abord si la premiere ligne
est vide et, dans le cas contraire, elle gjoute une virgule avant d'ajouter les don-
nées d'identité du bloc. L'instruction i f est nécessaire, car elle permet d'éviter
qu'une virgule apparaisse en début de ligne, avant le premier nombre, ce qui
pourrait perturber la lecture du programme i npressi on3D. py par la suite.

&

J

construireune machine
a dupliquer

Tu disposes maintenant de tous les saripts nécessaires pour développer ta propre
meachine a dupliquer en 3D, qui fera fureur chez tous tes amis ! Grace a dle, tu pour-
ras confectionner une salle a dupliquer dans le monde de Minecraft et aéer tous les
objets que tu veux. Tu pourras alors les conserver dans des f dhiers, les réintroduire
dans lasalle pour les modif er ou les reproduire comme par magie un peu partout dans
le monde. Enf n, tu pourras aussi tévader de ce monde et faire disparaitre la sale a
dupliquer sans laisser aucunetrace derrieretoi.

Al'instar des chapitres précédents, tu vas utiliser les programmes que tu as aéés et les
assembler pour obtenir un progranne plus grand. De méme, comme ce progranime
possede plusieurs fonctionnalités, tu vas rédiger un menu pour qu'il soit plus fadle a
manipuler.
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La premiére chose 4 faire est de concevoir la structure du programme pour qu’il tienne
en un seul morceau. Pour cela, tu vas commencer par rédiger des fonctions factices qui
ne feront quafficher leur nom lorsque tu les appelleras. Tu les compléteras par la suite
avec le contenu des fonctions de tes autres programmes. Clest exactement la méme
technique que tu as employée pour développer ton jeu de chasse au trésor dans le cha-
pitre 4, ten souviens-tu ?

1. Ouvre un nouveau fichier en cliquant sur File>New File et enregistre-le enle
nommant duplicateur.py.

2. Importe les modules dont tu as besoin :

import
import
import
import
import

mcpi.minecraft as minecraft
mcpi.block as block

glob

time

random

3. Connecte-toi au jeu Minecraft :

mc = minecraft.Minecraft.create()

4. Définis quelques constantes pour déterminer les dimensions de ta machine 4
dupliquer. Ne choisis pas des dimensions trop élevées, sinon ta machine 4 dupli-
quer tardera 4 scanner et & imprimer les objets. Pense également & définir la posi-
tion par défaut de ta salle de reproduction :

DIMENSIONSX = 10
DIMENSIONSY = 10
DIMENSIONSZ = 10
sallex = 1
salley = 1
sallez = 1

5. Rédige quelques fonctions d’apparat correspondant aux fonctionnalités du pro-
gramme. Tu les compléteras plus tard :

def constructionSalle(x, y, 2z):
print ("constructionSalle")

def demolitionSalle() :
print ("démolitionSalle")

def nettoyageSalle() :
print ("nettoyageSalle")

def repertoireFichiers() :
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print ("repertoireFichiers")

def scannage3D (nomdefichier, originex, originey, originez)
print ("scannage3D")

def impression3D(nomdefichier, originex, originey, originez):
print ("impression3D")

6. La fonction factice du menu est assez spéciale, car elle renvoie une valeur 4 1a fin
de son exécution. Pour l'instant, tu peux faire apparaitre une option aléatoire et
utiliser le mot-clé return pour tester les versions précédentes de ton programme.
Tu reviendras dessus plus tard pour le compléter. Si tu rédiges un menu factice,
Cest pour pouvoir tester la structure de ton programme. Tu le modifieras plus
tard pour en faire un vrai menu :

def menu() :
print ("menu")
time.sleep (1)
return random.randint (1,7)

7. Rédige la boucle de jeu principale qui va te permettre d’afficher le menu et d'utili-
ser la fonction correspondant a cette fonctionnalité. Pour en savoir plus sur l'uti-
lisation de la variable anotherGo, lis 'encadré « Percer les secrets du code » :

anotherGo = True
while anotherGo:
choix = menu()
if choix == 1:
pos = mc.player.getTilePos ()
constructionSalle (pos.x, pos.y, pos.z)
elif choix == 2:
repertoireFichiers ()
elif choix ==
nomdefichier = raw_input ("nom du fichier ?")
scannage3D (nomdefichier, sallex+l, salley+l, sallez+l)
elif choix ==
nomdefichier = raw_input ("nom du fichier ?")
impression3D (nomdefichier, sallex+l, salley+l, sallez+l)
elif choix ==
scannage3D ("scantemp", sallex+l, salley+l, sallez+1l)
pos = mc.player.getTilePos ()
impression3D ("scantemp", pos.x+l, pos.y, pos.z+l)
elif choix == 6:
nettoyageSalle ()
elif choix ==
demolitionSalle ()
elif choix ==
anotherGo = False
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Sauvegarde ton programme de test puis exécute-le. Que se passe-t-il ? Sur la figure 6-7,
tu peux voir ce qui s'est affiché lorsque j’ai exécuté le programme sur mon ordinateur : il
t'indique en effet les opérations qu'il effectue, cest-a-dire qu’il choisit une entrée du menu
de maniére aléatoire, puis il exécute la fonction que cette entrée renferme. Comme les
fonctions n'affichent que leur nom, clest tout ce que tu peux voir pour l'instant. La suite
de mots qui s'affichera sur ton écran sera différente de celle de la figure 6-7, car la fonction
menu () choisit une entrée au hasard 4 chaque fois que ton programme y fait appel.

74 *Python 2.7.6 Shell*

File Edit Shell Debug Options Windows Help
Python 2.7.6 (default, Nov 10 2013, 19:24:18) [MSC v.1500 32 bit (Intel)] on win32
Type "copyright", "credits" or "license ()" for more information.

>>> RESTART
>>>

menu

repertoireFichiers

menu

demolitionSalle

menu

constructionSalle
menu

scannage3D
impression3D

menu
repertoireFichiers
menu

nom du fichier ?

Ln:5

FIGURE 6-7 Ce qui s'affiche aprés I'exécution du programme de test

\)EF/A,,))

Linstruction return permet de renvoyer la valeur d'une fonction lorsqu’elle
retourne dans le programme qui a appelé la fonction pour la premiére fois.

Par exemple, lorsque tu souhaites obtenir un nombre au hasard, tu appelles la
fonction random.randint (). Cette fonction renvoie une valeur que tu peux
alors stocker dans une variable, comme ceci: a = random.randint (1,100).
Le mot-clé return dans le langage Python te permet d’utiliser exactement la
méme technique de renvoi de valeurs au sein de tes propres fonctions.

La fonction raw_input () permet de lire une ligne de texte saisie a I'aide du
clavier. Si tu saisis une chaine de caractéres entre les parenthéses, cette chaine
de caracteres sera utilisée comme invite de commandes, donc l'instruction nom
= raw_input ("Comment t'appelles -tu ?") pose une question dont elle
recevra également la réponse.

Lorsque tu utilises raw_input () pour lire du texte saisi au clavier, la fonction te
renvoie toujours une chaine de caracteres. Si tu souhaites saisir un nombre (par
exemple, dans ton menu), tu devras utiliser la fonction int () pour convertir la
chaine de caractéres lue en nombre. Certains programmeurs Python préférent
rédiger cette commande sur une seule et méme ligne, comme ceci : age =
int (raw_input ("Quel age as-tu ?")).
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Tout au long de ce livre, tu as utilisé la version 2 du langage Python. Si tu changes
d'ordinateur, il se peut que la version 3 y soit installée. Ces deux versions du
langage différent sur plusieurs points. Par exemple, dans la version 3, tu dois
utiliser la fonction input () au lieu de la fonction raw_input () propre a la
version 2. Dans ce livre, j'ai choisi d'utiliser la version 2 du langage Python, car
I'API de Minecraft est congue pour fonctionner uniquement avec celle-ci. Si tu
souhaitais utiliser la version 3, tu serais obligé d'effectuer des modifications.

PERCER LES SECRETS DU CODE

Méme si tu as déja utilisé des variables en booléen dans les chapitres précé-
dents, je te recommande vivement de t'arréter quelques secondes pour com-
prendre la maniéere dont la variable anotherGo a été utilisée dans le programme
duplicateur.py. En voici les lignes le plus importantes :

anotherGo = True
while anotherGo:
choix = menu()
if choix == 8:
anotherGo = False

En programmation, la structure de cette boucle est assez commune : elle se
répete au moins une fois, te demande si tu veux engager un autre tour et, en
cas de réponse négative, met fin a la boucle. Il existe plusieurs manieres d'ar-
river au méme résultat en Python, notamment en utilisant une variable bool-
éenne, qui constitue une option idéale, car elle permet de voir clairement
comment le programme fonctionne.

Python dispose d'une instruction nommée break, qui permet de briser une
boucle. Méme si tu ne vas pas |utiliser dans ce livre, tu peux toujours effectuer
une recherche sur Internet et t'amuser a modifier ta boucle en remplagant la
variable booléenne par cette instruction break.

\§ J
oEF/A,,»

Une variable booléenne est une variable qui ne peut prendre qu‘une valeur (&)
sur deux, soit True ou False. Elles tiennent leur nom du mathématicien =
George Boole, qui a beaucoup travaillé sur la logique formelle dans les années
1980, une discipline qui a permis de poser les fondements de I'informatique
moderne. Tu peux en lire davantage sur Boole en te rendant sur cette page :
http://fr.wikipedia.org/wiki/George Boole.

. J
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Ajouter un menu a ton programme peut s’avérer trés utile s'il propose beaucoup d'op-
tions. Ce menu affiche toutes les options disponibles et effectue un tour de boucle, en
attendant que tu saisisses le numéro de I'une d’elles. Si tu saisis un mauvais numéro, le
menu s’affichera 4 nouveau en te demandant de réessayer.

1. Modifie la fonction du menu et remplace-la par les lignes de code suivantes
(attention a I'indentation) :

def menu() :
while True:
print ("MENU DU DUPLICATEUR")
print (" 1. CONSTRUIRE la salle de reproduction")
print (" 2. AFFICHER les fichiers existants")
print (" 3. SCANNER le contenu de la salle de ¢
reproduction dans un fichier")
print (" 4. CHARGER le contenu d'un fichier dans €
la salle de reproduction")
print (" 5. IMPRIMER le contenu de la salle de <
reproduction en face de Steve")
print (" 6. NETTOYER la salle de reproduction")
print (" 7. DEMOLIR la salle de reproduction")
print (" 8. FERMER")
choix = int (raw_input («choix : «))
if choix < 1 or choix > 8:
print ("Tu dois choisir un chiffre entre 1 et 8")
else:
return choix

Enregistre ton programme et exécute-le. Qulest-ce qui change par rapport au menu
factice ? Sur la figure 6-8, tu peux voir ce & quoi ressemble le vrai menu.

File Edit Shell Debug Options Windows Help
Python 2.7.6 (default, Nov 10 2013, 19:24:18) [MSC v.1500 32 bit (Intel)] on win :J
32

Type "copyright"™, "credits" or "license()" for more information.
>>> RESTART
>>>
MENU DU DUPLICATEUR
1. CONSTRUIRE la salle de reproduction
2. AFFICHER les fichiers existants
3. SCANNER le contenu de la salle de reproduction dans un fichier
4. CHARGER le contenu d'un fichier dans la salle de reproduction

5. IMPRIMER le contenu de la salle de reproduction en face de Steve
6

7

8
ch

. NETTOYER la salle de reproduction
. DEMOLIR la salle de reproduction
. FERMER

oix :

Ln: 5 CohOl

FIGURE 6-8 Le menu
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En posant la structure de ton programme, avec son menu et toutes ses fonctions
factices, puis en le complétant en détail fonction par fonction et en le testant, tu
travailles exactement comme le ferait un ingénieur professionnel qui développe
ses propres applications informatiques. La meilleure méthode pour concevoir un
programme consiste en effet a |'écrire pas a pas, en testant tes changements au
fur et a mesure, jusqu’a ce que tu en viennes a bout. De cette maniére, tu pourras
faire une démonstration a quiconque te le demandera en un rien de temps !

La salle de reproduction sera en verre et sera ouverte d’'un c6té pour que ton joueur
puisse y entrer et facilement créer ou supprimer des blocs a l'intérieur.

Pour cela, tu dois remplacer la fonction constructionsalle () par les lignes de
code suivantes. Fais attention aux lignes longues qui se trouvent dans la fonction
setBlocks (). Tu remarqueras cependant que je n’ai pas utilisé la fleche J dans les
lignes suivantes, car ici Python me permet de les diviser en plusieurs lignes (pour en
savoir plus sur cette exception, tu peux lire I'encadré « Percer les secrets du code ») :

def constructionSalle(x, y, 2z):

global sallex, salley, sallez

sallex = x

salley = y

sallez = z

mc.setBlocks (sallex, salley, sallez,
sallex+DIMENSIONSX+2, salley+DIMENSIONSY+2,
sallez+DIMENSIONSZ+2, block.GLASS.id)

mc.setBlocks (sallex+l, salley+l, sallez,
sallex+DIMENSIONSX+1l, salley+DIMENSIONSY+1,
sallez+DIMENSIONSZ+1l, block.AIR.id)

Sauvegarde ton programme et exécute-le & nouveau. Essaye loption 1 du menu pour
t’assurer que ton programme te permet bien de construire la salle de reproduction.
Déplace-toi dans Minecraft et choisis 'option 1 4 nouveau, puis regarde ce qu’il se
passe ! La figure 6-9 te montre la salle de reproduction telle que tu devrais la voir.
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FIGURE 6-9 La salle de reproduction construite sous tes yeux

PERCER LES SECRETS DU CODE

Python utilise I'indentation (espace ou tabulation) au début des lignes de code
pour distinguer les divers groupes d'instructions. Lorsque tu as utilisé des bou-
cles, les mots-clés if/else ou méme des fonctions, tu as indenté tes blocs
de code en fonction. En programmation, cette pratique est peu commune et
distingue le langage Python des autres langages de programmation comme le
C ou le C++, qui utilisent des caractéres spéciaux, tels que les accolades {},
pour regrouper des instructions. Tu dois donc faire particulierement attention a
I'indentation dans Python, sinon ton programme ne fonctionnera pas correcte-
ment !

La plupart du temps, Python ne te permet pas de séparer des lignes en plu-
sieurs morceaux, ce qui explique pourquoi tu vois souvent la fleche J dans ce
livre, qui t'indique que la ligne ne doit pas étre coupée.

Cependant, il existe deux autres méthodes pour traiter les lignes de code trop
longues dans Python.

La premiére méthode consiste a utiliser un caractére de continuation de ligne :
si le dernier caractére de ta ligne est une barre oblique inversée (\), cela veut
dire que tu peux passer a une autre ligne.

a=1
if a == 1 or \
a == 2:

print ("oui")
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Quant a la deuxieme méthode, elle consiste a couper une longue ligne de code
la ou il est évident qu’elle ne peut pas finir. Par exemple, lorsque tu définis des
valeurs initiales dans une liste ou quand tu utilises une fonction, tu peux tout a
fait couper tes lignes de code aux endroits ou Python saura pertinemment
qu’une suite est attendue. Ci-dessous, tu peux voir deux exemples probants
qui t'aideront a comprendre comment Python te permet de telles coupes. Les
crochets et parenthéses restés ouverts indiquent a Python que la ligne n’est
pas terminée et qu’elle finira des qu'ils se refermeront :

noms = ["David",

"Steve",

"Joan" ,

"Joanne"

1

mc.setBlocks (x1, yl1, z1,
X2, y2, z2, block.AIR.id)

Apres avoir exécuté ton programme de duplicateur A plusieurs reprises, tu finiras cer-
tainement avec de nombreuses salles de reproduction éparpillées un peu partout dans
Minecraft. Or a chaque fois, c’est la derniére que tu crées qui fonctionne réellement. Si
tu continues ainsi, tu te trouveras bient6t avec tellement de salles que tu ne sauras plus
ol donner de la téte | Pour remédier a ce probléme, tu vas devoir ajouter une fonction-
nalité A ton programme qui t'invitera & démolir ta salle de reproduction aprés ten étre
servi afin d'éviter que ton monde ne croule sous les vieux duplicateurs.

Ce programme de démolition ressemble en tous points au programme deblayage . py
du chapitre 3. Tout ce que tu as besoin de connaitre, ce sont les coordonnées extérieures
de ta salle. Et comme ta salle est plus grande d'un bloc par rapport a ton espace de
reproduction, qui lui est défini par DIMENSTONSX, DIMENSIONSY et DIMENSIONSZ, il
te suffira d’effectuer un simple calcul mathématique.

Modifie ta fonction demolitionSalle () pour quelle ressemble A ceci :

def demolitionSalle() :
mc.setBlocks (sallex, salley, sallez,
sallex+DIMENSIONSX+2, salley+DIMENSIONSY+2,
sallez+DIMENSIONSZ+2, block.AIR.id)

Enregistre ton programme et exécute-le & nouveau. Démolir ta salle de reproduction ne

devrait plus te poser de probléme. Choisis simplement l'option 1 de ton menu pour la
construire, puis l'option 7 pour la démolir.
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Tu as déja écrit cette partie du programme dans ton script scannage3D. py, donc tu
peux ten servir en y apportant de légéres modifications.

1.

Remplace la fonction scannage3D () par le code suivant. Ce code est presque
identique A celui du programme scannage3D.py. Seules les lignes en gras y ont
été ajoutées pour afficher la progression des opérations de scannage dans le chat
de Minecraft. En effet, scanner une grande salle peut prendre beaucoup de temps,
alors il est parfois bien pratique de connaitre 'avancée de ton programme pen-
dant son exécution. Pour gagner un peu de temps, copie et colle les lignes de code
de ton programme précédent :

def scannage3D (nomdefichier, originex, originey, originez):

2.

f = open(nomdefichier, "w")
f.write(str (DIMENSIONSX) + "," + str(DIMENSIONSY) + "," <
+ str (DIMENSIONSZ) + "\n")

for y in range (DIMENSIONSY) :
mc.postToChat ("scannage en cours :" + str(y))
f.write("\n")
for x in range (DIMENSIONSX) :
ligne = nmn
for z in range (DIMENSIONSZ) :
blockid = mc.getBlock (originex+x, <
originey+y, originez+z)
if ligne != "":
ligne = ligne + ","
ligne = ligne + str(blockid)
f.write(ligne + "\n")
f.close()

Enregistre ton programme et teste-le 4 nouveau. Pour cela, rends-toi dans la salle de
reproduction et construis quelque chose, puis choisis 'option 3 dans ton menu. Ouvre
le fichier qui a été créé pour vérifier que Lobjet a été scanné correctement. Sur la
figure 6-10, tu peux voir une partie d'un fichier scanné. Tu remarqueras qu'il contient
beaucoup de zéros. Cest parce que ta salle a également scanné tous les blocs ATR.

& caw:

Fichier

I coBE 5 GEe 4« hhloe|ithl+=BE%1EDEDEE Y

Ediion Recherche Affichage Encodage Langage Paramétrage Macro Exécution Compléments Documents 7 X

ervatore Tosv |

= obs:

16

1 ho,10,10

D

I

0,0,0,0,0,0,0,0,0,0

s 0,0,0,0,0,0,0,0,0,0

0,0,0,0,0,0,1,1,1,1

7 9,0,0,0,0,0,0,0,0,0 -

Normal

text file length:1585 lines: 84 Ln:1 Col:1 Sel:0 Dos\Windows ANSI INS

FIGURE 6-10 Le contenu d'un fichier scanné
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Besoin d’'un nettoyage de printemps ? Il peut parfois s'avérer bien pratique de recommen-
cer de zéro et de débarrasser la salle de tout ce qu'elle contient. Tu pourrais tout aussi bien
parvenir au méme résultat en la détruisant et en la reconstruisant, mais il est tellement
simple d’ajouter une fonctionnalité de nettoyage qu'il serait dommage de s'en passer. Tout
ce qui change par rapport 4 la fonction demolitionSalle (), ce sont les coordonnées.

1. Modifie la fonction nettoyagesalle () pour qu'elle ressemble au code sui-
vant. Tu noteras que les coordonnées de départ sont toutes supérieures aux coor-
données des parois de la salle et que les coordonnées de fin ne sont pas plus
élevées que celles de la fonction demolitionSalle (). De cette maniére, tu vas
nettoyer I'espace intérieur de la salle sans en détruire les murs :

def nettoyageSalle() :
mc.setBlocks (sallex+l, salley+l, sallez+l,
sallex+DIMENSIONSX+1l, salley+DIMENSIONSY+1,
sallez+DIMENSIONSZ+1l, block.AIR.id)

2. Sauvegarde ton programme et exécute-le & nouveau. Crée un objet dans la salle
puis choisis I'option 6 pour savoir si tu es capable de nettoyer la salle en un cla-
quement de doigts.

Imprimer (ou reproduire) un objet qui se trouve dans ta salle est une opération on ne
peut plus simple A réaliser, car tu as déja rédigé le programme qui te permet de le faire :
il s’agit de ton programme impression3D.py. Le voici mis en contexte :

def impression3D(nomdefichier, originex, originey, originez):
f = open(nomdefichier, "r")
lignes = f.readlines()
coords lignes[0] .split (", ")
dimensionsx = int (coords[0])
dimensionsy = int (coords[1])
dimensionsz = int (coords[2])
idxligne = 1
for y in range (dimensionsy) :
mc.postToChat ("impression en cours:" + str(y))
idxligne = idxligne + 1
for x in range (dimensionsx) :
ligne = lignes[idxligne]
idxligne = idxligne + 1
donnee = ligne.split(",")
for z in range (dimensionsz) :
blockid = int (donnee[z])
mc.setBlock (originex+x, originey+y,
originez+z, blockid)
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Enregistre ton programme et exécute-le 4 nouveau. Construis un objet dans la salle
puis déplace-toi dans le jeu et choisis l'option 5 du menu. Tout ce qui se trouve dans ta
salle sera scanné puis reproduit juste & c6té de ton joueur. Tu peux répéter lopération
autant de fois que tu le souhaites et reproduire des objets un peu partout dans Mine-
craft. Essaye d'en reproduire dans le ciel et sous 'eau pour voir ce qu'il se passe ! Sur la
figure 6-11, tu peux voir le résultat de I'opération aprés l'exécution du programme.

A Minecraft 1.6.4

FIGURE 6-11 Un rocher reproduit a l'identique a cété du joueur

Ta derniére mission consiste 4 écrire une petite fonction bien pratique qui va te per-
mettre de répertorier tous les fichiers dans un systéme de gestion de fichiers CSV. Tu
pourrais aussi bien utiliser ton propre gestionnaire de fichiers pour cela, mais il est
quand méme plus intéressant d'ajouter cette fonctionnalité A ton programme, car tu
auras ainsi tout ce dont tu as besoin dans un seul et méme endroit :

1. Modifie la fonction repertoireFichiers () pour pouvoir utiliser la fonction
glob.glob () quilira tous les fichiers d’'un répertoire et les imprimera. Pour en
savoir plus sur cette fonction, référe-toi a 'encadré « Percer les secrets du code ».

def repertoireFichiers() :
print ("\nFICHIERS:")
fichiers = glob.glob("*.csv")
for nomdefichier in fichiers:
print (nomdefichier)
print ("\n")
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2. Enregistre ton programme et exécute-le & nouveau. Scanne quelques objets dans
des fichiers CSV, choisis 'option 2 dans le menu et assure-toi qu'aucun objet ne
manque. Sur la figure 6-12, tu peux voir les fichiers que jai créés lorsque j'ai exé-
cuté ce programme sur mon ordinateur.

File Edit Shell Debug Options Windows Help

Python 2.7.6 (default, Nov 10 2013, 19:24:18) [MSC v.1500 32 bit (Intel)] on win *
32
Type "copyright"”, "credits" or "license()" for more information.
>>> RESTART
i >>>
MENU DU DUPLICATEUR
. CONSTRUIRE la salle de reproduction
. AFFICHER les fichiers existants
. SCANNER le contenu de la salle de reproduction dans un fichier
. CHARGER le contenu d'un fichier dans la salle de reproduction
. IMPRIMER le contenu de la salle de reproduction en face de Steve
. NETTOYER la salle de reproduction
. DEMOLIR la salle de reproduction
8. FERMER
choix : 2

FICHIERS:
labyrinthel.csv
objetl.csv
objet2.csv
observatoirel.csv

MENU DU DUPLICATEUR
. CONSTRUIRE la salle de reproduction
. AFFICHER les fichiers existants
. SCANNER le contenu de la salle de reproduction dans un fichier
. CHARGER le contenu d'un fichier dans la salle de reproduction
. IMPRIMER le contenu de la salle de reproduction en face de Steve
. NETTOYER la salle de reproduction
. DEMOLIR la salle de reproduction

8. FERMER
choix :|

FIGURE 6-12 Le répertoire des fichiers CSV que tu as créés

PERCER LES SECRETS DU CODE

glob.glob () : quel curieux nom pour une fonction ! Si dréle qu’on le répete
méme deux fois !

Sile nom glob est utilisé deux fois, c’est parce que la premiére occurrence est
le nom du module (le module glob) depuis lequel il a été importé au début du
programme. La deuxiéme est le nom de la fonction glob qui se trouve a l'in-
térieur du module du méme nom.

Mais a quoi sert la fonction glob et pourquoi porte-t-elle ce nom ?
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Pour ce qui concerne le nom, il sagit simplement de I'abréviation de I'expres-
sion « global command » (commande de base, en frangais), qui remonte aux
tous débuts du systéme d’exploitation d'Unix. Pour en savoir plus sur I'histoire
qui se cache derriére |'abréviation glob, tu peux lire I'article de I'encyclopédie
Wikipédia qui y est consacré (en anglais) : http://en.wikipedia.org/
wiki/Glob_ (programming).

Quant a son utilité, elle permet d'obtenir une liste de fichiers répondant a une
recherche précise ou a un métacaractére. Par exemple, lorsque tu utilises
glob.glob ("*.csv"), Python analyse le répertoire dans le systtme de ton
ordinateur et affiche une liste de tous les fichiers se terminant par .csv.

Donc, si tu as placé les fichiers un.csv, deux.csv et trois.csv dans ton
dossier MyAdventures et que tu utilises glob.glob ("*.csv"), tu obtien-
dras une liste Python qui ressemble a cela :

[‘un.csv', ‘deux.csv', ‘trois.csv']

Or, souviens-toi que la boucle for parcourt tous les éléments d'une liste. Dong,
retiens bien les lignes de code suivantes, car elles sont trés utiles :

for nom in glob.glob("*.csv")
print (nom)

DEFIy,,
© Un métacaracteére est un caractére spécial qui permet de sélectionner plusieurs
noms ou mots identiques. Il fonctionne un peu comme un « joker » dans un jeu
de cartes, car il peut représenter tout et n‘importe quoi.

En Python, le métacaractére est souvent utilisé pour sélectionner plusieurs
fichiers du méme format dans un répertoire, par exemple tous les fichiers de type
« CSV ». Pour cela, on utilise glob.glob ("*.csv"). Dans cette commande,
I'astérisque (*) indique la position du métacaractere et la fonction glob.glob ()
trouvera tous les fichiers . csv que contient I'ordinateur.
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DEFI

Si tu saisis un nom de fichier qui n’existe pas dans ton programme
duplicateur.py, ce dernier va planter en t'indiquant une erreur et va laisser ta
salle de reproduction telle quelle dans le monde de Minecraft, sans la détruire.
Essaye d'améliorer ton programme en recherchant sur Internet un moyen de
détecter les fichiers non existants pour éviter que ton programme ne plante.

Lorsque Martin a testé mon programme duplicateur.py, il y a trouvé un
bug : la salle de reproduction est en effet plus grande qu’elle devrait I'étre. Cela
veut dire que si tu construis un objet de la taille de ta salle, une portion de blocs
ne sera pas scannée dans le fichier. Donc ton objet sera reproduit sans cette
portion de blocs. Cela pourrait devenir génant, surtout si tu construis une mai-
son | Essaye de détecter la cause de ce bug et de voir si tu peux le réparer.

Tableau de références

Lire des lignes dans un fichier

crire des lignes dans un fichier

f = open("données.txt", "r")
astuces = f.readlines()
f.close()

for t in astuces:

print (t)

= open("scores.txt", "w")
write ("Victoria:26000\n")
write ("Amanda:10000\n")

E
£
£
£
f.write("Ria:32768\n")
£

close()

Obtenir une liste de noms

Enlever des espaces blancs en trop

de fichiers analogues dans des chaines de caractéres
import glob a = "\n\n salut \n\n"
noms = glob.glob("*.csv") a = a.strip()
for n in noms: print (a)
print (n)

Explorer d'autres pistes
avec les fichiers de données

Dans ce chapitre, tu as appris 4 lire et 4 écrire dans des fichiers de données. Cela touvre
d'infinies possibilités d'enregistrer et de restaurer des parties du monde de Minecraft
et méme d’introduire d'immenses volumes de données que tu peux trouver ailleurs, sur
des sites Internet par exemple. Tu as aussi construit ton propre labyrinthe en 3D en le
dotant d’'innombrables couloirs sinueux et d'impasses. Puis tu as terminé en batissant
une imprimante 3D en parfait état de fonctionnement, avec un menu trés complet, qui
va d’ailleurs te servir dans beaucoup de programmes !

* 1l existe toute une panoplie de sites Internet recensant des « données en temps
réel ». Lors de mes recherches pour la préparation de ce livre, je suis tombé sur un
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site qui recense les données de stationnement de la ville de Nottingham :
http://data.nottinghamtravelwise.org.uk/parking.xml. Ces données
sont mises 4 jour toutes les cinq minutes et fournissent un suivi de toutes les entrées
et sorties des aires de stationnement de la ville. J'ai écrit a 'occasion un programme
Python qui traite ces données et reproduit des informations utiles, comme tu peux
le voir sur ma page GitHub : https://github.com/whaleygeek/pyparsers.
Essaye d'utiliser ce programme pour créer un jeu dans Minecraft avec des aires de
stationnement et des voitures A 'intérieur. Tu pourrais par exemple en faire un jeu
de chasse 4 1a place de stationnement en temps limité !

* Tout ce que tu as toujours voulu savoir sur les labyrinthes en 3D est expliqué en
détail sur ce site web : http: //www.astrolog.org/labyrnth/algrithm.htm.
Cette page inclut un tas d’exemples de labyrinthes en 3D multijoueurs, qui sont
enregistrés dans des fichiers de traitement de texte ordinaires. Parcours un peu le
site et vois si tu peux trouver un fichier de labyrinthe multijoueurs. Modifie ensuite
ton programme de labyrinthe pour te servir des techniques apprises lors de la créa-
tion de l'imprimante 3D et crée un immense labyrinthe composé de plusieurs
couches. Sile cceur t'en dit, tu pourras méme t'inspirer des quelques conseils du site
pour écrire un programme capable de produire des labyrinthes automatiquement !

Niveau terminé : bravo ! Tu as réussi 4 briser les lois de la physique en faisant magi-
quement apparaitre et disparaitre d'immenses objets dans Minecraft, tout ¢a en un
claquement de doigts !

Dans le prochain chapitre...

Dans le chapitre 7, tu vas apprendre a construire des objets complexes en 2D et en
3D a I'aide de Python. Tu apprendras notamment a contrdler la course folle du temps
en construisant une horloge géante, a batir des polygones et autres objets complexes
avec quelques lignes de code et a mener une expédition hors du commun sur les
sentiers des pyramides !

o J
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